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RX Family 

QE for Display [RX] Application Note 

Summary 

QE for Display [RX] is a plug-in for the e2 studio integrated development environment with support for 
suitable Renesas RX microcontrollers and provides a graphical interface for display control to assist in the 
development of embedded systems incorporating display devices. 

Along with display control, QE for Display [RX] 2.0.0 and later versions are also capable of embedding 
emWin GUIs, which are based on a high-performance graphics library from SEGGER. The emWin library is 
a high-reliability embedded GUI solution which has been adopted in various fields such as industrial, IoT, 
network, automotive, healthcare, and aviation. It supports all kinds of displays, achieves high performance 
while minimizing the footprint in memory, and the GUIs can be embedded in a great variety of systems. In 
addition, the emWin bundle incorporates the AppWizard, a powerful GUI drawing tool which makes it easy to 
configure an excellent GUI through intuitive operations. 

Earlier versions of QE for Display [RX] (up to V1.1.0) consisted of the display adjustment facilities provided 
for the graphics LCD controller (GLCDC) which is in several RX-family products and sample programs that 
were added to QE for Display [RX] to ease the adjustment of displays in user project. 

QE for Display [RX] covers everything from the initial adjustment of the display to the creation of designs for 
screens. It can also be interlinked with various GUI development solutions to provide total support for the 
development of GUIs within short timeframes. 

This application note describes the procedures for development with the use of QE for Display and tools with 
which its operation can be interlinked. 

 

Target Devices 

• RX65N and RX651 groups (ROM capacity: 1.5 MB to 2 MB) 

• RX72N group 

• RX72M group 

• RX66N group 
 
For the procedures described in this application note, operation in one of the following environments is 
assumed. 

• Renesas Starter Kit+ for RX72N 

• Renesas Envision KIT RPBRX72N 

• Renesas Starter Kit+ for RX65N-2MB 

• Renesas Envision KIT RPBRX65N 
 
When you apply this application note with a different device or board, adjust the settings to be appropriate 
and thoroughly evaluate the results. 
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1. Overview 

As shown in Figure1-1, the GLCDC has multiple blocks, so simply checking the display attributes requires an 
understanding of the GLCDC specifications and a large number of settings. However, QE for Display [RX] 
makes it possible to prepare an environment in which the connection of the display device can be checked in 
a short time without needing a full understanding of the GLCDC specifications. QE for Display [RX] is a tool 
that provides a graphical interface for display control and a facility for adjusting the timing in real time with the 
display device connected. After timing adjustment, a header file containing the corresponding information for 
display control is output. Settings for the GLCDC are then made on the basis of this header file. 

The AppWizard GUI drawing tool allows you to design an interactive GUI in a short time by combining the 
prepared resources and settings in the AppWizard editor without having to spend a long time for reading 
manuals or coding programs. The tool also allows the efficient implementation of detailed specifications in 
response to various demands by using the API functions provided by the emWin library. 

QE for Display [RX] can also be used with the Smart Configurator, which simplifies embedding of the 
Renesas drivers, and Firmware Integration Technology (FIT), which provides drivers and middleware for the 
RX family. These tools can further simplify display control and the creation and display of GUIs. 

This application note mainly concerns the use of provided FIT modules and the Smart Configurator with QE 
for Display [RX] as the nucleus. The specific FIT modules are the Firmware Integration Technology (GLCDC 
FIT) module for the graphics LCD controller and the emWin Firmware Integration Technology (emWin FIT) 
module. 

The flowchart on the following page describes the basic procedure for developing systems with the use of 
QE for Display [RX]. 

 

 

Figure1-1   Block Configuration of the GLCDC 
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1.1 Flow of System Development with QE for Display [RX] 

Figure1-2 shows a flow of system development with the use of QE for Display [RX]. 

 

 

Figure1-2   System Development by Using QE for Display [RX] 
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2. Operating Environment 

The procedures described in this application note assume operation on the Renesas Starter Kit+ for RX72N 
(RSK RX72N), the Renesas Envision Kit RPBRX72N (Envision RX72N), the Renesas Starter Kit+ for 
RX65N-2MB (RSK RX65N) and the Renesas Envision Kit RPBRX65N (Envision RX65N). Table 2-1 shows 
the development environment for this application note. 

 

Table 2-1   Development Environment 

Item Contents 

Integrated development 

environment 

Renesas Electronics 

e2 studio 2020-07 

C compiler Renesas Electronics 

C/C++ Compiler Package for RX Family V.3.02.00 

Compiler option 

-lang = C99 

 

 

Table 2-2 to Table 2-5 list the conditions used in confirming operations on each of the boards. 

 

Table 2-2   Conditions for Confirming Operation (RSK RX72N) 

Item Contents 

MCU used R5F572NNDDBD (RX72N Group) 

Operating frequency • Main clock: 24 MHz 

• PLL: 240 MHz (main clock x 1/1 x 10) 

• System clock (ICLK): 240 MHz (PLL x 1/1) 

• Peripheral module clock A (PCLKA): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

• LCD panel clock (LCD_CLK): 10 MHz (PLL x 1/24) 

Endian Little endian or Big endian 

Emulator E2 Lite 

Connection type JTAG or FINE 

Board used Renesas Starter Kit+ for RX72N 

(product No.: RTK5572NNxxxxxxxxx) 
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Table 2-3   Conditions for Confirming Operation (Envision RX72N) 

Item Contents 

MCU used R5F572NNHDFB (RX72N Group) 

Operating frequency • Main clock: 16 MHz 

• PLL: 240 MHz (main clock x 1/1 x 15) 

• System clock (ICLK): 240 MHz (PLL x 1/1) 

• Peripheral module clock A (PCLKA): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

• LCD panel clock (LCD_CLK): 10 MHz (PLL x 1/24) 

Endian Little endian or Big endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type FINE 

Board used Renesas Envision KIT RPBRX72N   

(product No.: RTK5RX72N0CxxxxxBJ) 

Board settings 

(jumper/switch)  

<SW1> 

Pin 1: don't care 

Pin 2: OFF 

 (The debugger is used.)  

<Others> 

Default settings 

 

Table 2-4   Conditions for Confirming Operation (RSK RX65N) 

Item Contents 

MCU used R5F565NEDDFC (RX65N Group) 

Operating frequency • Main clock: 24 MHz 

• PLL: 240 MHz (main clock x 1/1 x 10) 

• System clock (ICLK): 120 MHz (PLL x 1/2) 

• Peripheral module clock A (PCLKA): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

• LCD panel clock (LCD_CLK): 10 MHz (PLL x 1/24) 

Endian Little endian or Big endian 

Emulator E2 Lite 

Connection type JTAG or FINE 

Board used Renesas Starter Kit+ for RX65N-2MB  

(product No.: RTK50565Nxxxxxxxxx) 

Board settings 

(jumper/switch)  

<SW4> 

Pin 3: OFF 

Pin 4: ON 

 (The LCD is used.)  

<Others> 

Default settings 

 
  



RX Family QE for Display [RX] Application Note 

R20AN0582EJ0110  Rev.1.10  Page 8 of 113 

Dec.25.20  

Table 2-5   Conditions for Confirming Operation (Envision RX65N) 

Item Contents 

MCU used R5F565NEDDFB (RX65N Group) 

Operating frequency • Main clock: 12 MHz 

• PLL: 240 MHz (main clock x 1/1 x 20) 

• System clock (ICLK): 120 MHz (PLL x 1/2) 

• Peripheral module clock A (PCLKA): 120 MHz (PLL x 1/2) 

• Peripheral module clock B (PCLKB): 60 MHz (PLL x 1/4) 

• LCD panel clock (LCD_CLK): 10 MHz (PLL x 1/24) 

Endian Little endian or Big endian 

Emulator E2 OB (E2 emulator On Board) 

Connection type JTAG or FINE 

Board used Renesas Envision KIT RPBRX65N 

(product No.: RTK5RX65N2CxxxxxBR) 

Board settings 

(jumper/switch)  

<SW1> 

Pin 1: ON 

Pin 2: OFF 

 (The debugger is used.)  

<SW4> 

Pin 1: OFF 

Pin 2: don't care 

 (The debugger is used.)  

<Others> 

Default settings 
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3. Related Documents 

Also refer to the following documents which are related to this application note. 

 

Table 3-1   Documents Related to FIT Modules 

Document Title Document No. 

Firmware Integration Technology User's Manual R01AN1833 

RX Family Board Support Package Firmware Integration Technology Module R01AN1685 

RX Family Graphic LCD Controller Module Using Firmware Integration Technology R01AN3609 

RX Family emWin v.6.14 module Using Firmware Integration Technology Application 

Note 

R01AN5533 

 

Table 3-2   Document Related to Tools 

Document Title Document No. 

Renesas e2 studio Smart Configurator User Guide R20AN0451 

 

Table 3-3   Documents Related to Boards 

Document Title Document No. 

RX65N Group Renesas Starter Kit+ for RX65N-2MB User’s Manual R20UT3888 

RX65N Group RX65N Envision Kit User's Manual R01UH0761 

RX72N Group Renesas Starter Kit+ for RX72N User’s Manual R20UT4443 

RX72N Group RX72N Envision Kit User's Manual R20UT4788 

 

Table 3-4   Documents Related to Devices 

Document Title Document No. 

RX65N Group, RX651 Group User's Manual: Hardware R01UH0590 

RX72N Group User’s Manual: Hardware R01UH0824 

 

 

Please use the latest versions that are available. Visit the Renesas Electronics Web site to check and obtain 
the latest versions.  
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4. Procedures for Execution 

This chapter describes the procedures for creating a new project in the e2 studio, using QE for Display [RX] 
to adjust the display in real-time, designing the GUI, and displaying the resulting project. 

The results of adjusting the display produced by the GLCDC and of emWin which enables the efficient 
creation of the GUI, are generated as FIT modules for embedding in the project by using the Smart 
Configurator. Since the settings for GLCDC and emWin can be made from the GUI of QE for Display [RX], 
the user can smoothly proceed with GUI development according to the workflow. 

Before starting this project, be sure to make the jumper settings stated in chapter 2, Operating Environment, 
if this is required. 

For the usage of QE for Display [RX], refer to chapter 6, Using QE for Display [RX]. 

 

Preparation 

1. Installing QE for Display [RX] 
 
Procedure 

2. Creating a new project 

3. Making the board, clock, and heap size settings 

4. Making the GLCDC and emWin settings according to the workflow of QE for Display [RX] 

5. Building the project 

6. Connecting a debugger and executing the program 
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4.1 Installing QE for Display [RX] 

Install QE for Display [RX] in the e2 studio integrated development environment. Use the following procedure 
to install this product. 

 

4.1.1 Installing QE for Display [RX] 

4.1.1.1 Updating the e2 studio by using its installer 

For updating the e2 studio, refer to section 3, Updating Your Product, described in “[Upgraded to version] e2 
studio 2020-07” in Renesas Tool News (document No. R20TS0592EJ0100). 

https://www.renesas.com/search/keyword-search.html#genre=document&q=r20ts0592 

 

Select “QE for Display” for “Additional Software” in the installer of the e2 studio. 

Notes: 1. Since this step is not possible in situations where an Internet connection is not available, update 

QE for Display [RX] with the method described in section 4.1.1.3, Installing QE for Display [RX] by 

using the installer of QE 

 2. Use e2 studio 2020-07 or a later version. 
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4.1.1.2 Installing QE for Display [RX] by using the installer of the e2 studio 

Refer to the following for how to install QE for Display [RX]. 

1. Start the e2 studio. 

2. Select the “Renesas Software Installer” menu item from “Renesas Views” to open the “Renesas Software 

Installer” dialog box. 

3. Select “Renesas QE” and click on the “Next” button. 

4. Select the “QE for Display[RX] (v2.0.0)” checkbox and click on the “Finish” button. 

5. Confirm that the “Renesas QE for Display[RX]” checkbox has been selected in the “Install” dialog box and 

click on the “Next” button. 

6. Confirm that “Renesas QE for Display[RX]” is selected as the target of installation and click on the “Next” 

button. 

7. After confirming the license agreement, select the “I accept the terms of the license agreements” radio 

button if you agree with the license agreement, and click on the “Finish” button. 

8. If the dialog box for the trust certificate is displayed, confirm the certificate and click on the “OK” button to 

continue installation. 

9. Restart the e2 studio by following the instructions on the screen. 

10. Start this product from the “Renesas QE” menu under “Renesas Views” of the e2 studio. 
 
Note: Since this step is not possible in situations where an Internet connection is not available, download 

the installer of QE in a different environment and update QE for Display [RX] with the method 

described in section 4.1.1.3, Installing QE for Display [RX] by using the installer of QE. 

. 

 

4.1.1.3 Installing QE for Display [RX] by using the installer of QE 

Download the installer from the following URL for installation. 

• QE for Display V2.0.0: Development Assistance Tool for Display 

https://www.renesas.com/qe-display#downloads 
 
Refer to the following for how to install QE for Display [RX]. 

1. Start the e2 studio. 

2. Select the “Install New Software...” menu item from the “Help” menu to open the “Install” dialog box. 

3. Click on the “Add...” button to open the “Add Repository” dialog box. 

4. Click on the “Archive” button, select the zip file for installation in the dialog box for selecting a file that has 

opened, and click on the “Open” button. 

5. Click on the “OK” button in the “Add Repository” dialog box. 

6. Expand the “Renesas QE” item shown in the “Install” dialog box, select the “Renesas QE for Display[RX]” 

checkbox, and then click on the “Next” button. 

*You can deselect the “Contact all update sites during install to find required software” checkbox to 

shorten the installation time. 

7. Confirm that the target of installation is correctly selected and click on the “Next” button. 

8. After confirming the license agreement, select the “I accept the terms of the license agreements” radio 

button if you agree with the license agreement, and click on the “Finish” button. 

9. If the dialog box for the trust certificate is displayed, confirm the certificate and click on the “Accept 

selected” button to continue installation. 

10. Restart the e2 studio by following the instructions on the screen. 

11. Start this product from the “Renesas QE” menu under “Renesas Views” of the e2 studio. 
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4.1.2 Uninstalling QE for Display [RX] 

To uninstall QE for Display [RX], follow the procedure below. 

1. Start the e2 studio. 

2. From the “Help” menu, select the “About e2 studio” menu item, click on the “Installation Details” button to 

open the “e2 studio Installation Details” dialog box. 

3. Select “Renesas QE for Display[RX]” displayed on the “Installed Software” tabbed page and click on the 

“Uninstall...” button to open the “Uninstall” dialog box. 

4. Confirm the displayed information and click on the “Finish” button. 

5. Restart the e2 studio by following the instructions on the screen. 
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4.2 Creating a New Project 

Create a project with the e2 studio. 

1. Click on “File” -> “New”, and then “C/C++ Project”. 
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2. Select “Renesas RX” -> “Renesas CC-RX C/C++ Executable Project” and click on “Next”. 
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3. Enter the name of the project in the “Project name:” text box and click on “Next”. 
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4. Select the board to be used from the “Target Board:” combo box. After selecting the target board, the 

selection from the “Target Device:” combo box is automatically made. 

If the board to be used is not among the available selections, downloading a board description file (BDF) 

is required when the Smart Configurator is set after the project has been created. 

In such cases, select “Custom” for “Target Board:” and select the MCU to be used from “Target Device:”. 

5. Confirm that the checkbox for “Create Hardware Debug Configuration” is selected and select the emulator 

to be used from the combo box below it. Click on “Next”. 
 
Table 4-1   Correspondence between Target Board, Target Device, and Emulator 

Target Board Target Device Emulator 

EnvisionRX65N R5F565NEDxFB E2 Lite (RX) 

RSKRX65N-2MB R5F565NEDxFC E2 Lite (RX) 

EnvisionRX72N R5F572NNHxFB E2 Lite (RX) 

RSKRX72N R5F572NNDxBD E2 Lite (RX) 
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6. Select the “Use Smart Configurator” checkbox. 

7. Click on “Finish”. 
 

 

 

8. When the following message is displayed, click on “Open Perspective”. 
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9. The project is created and the Smart Configurator is opened. 
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4.3 Making the Board, Clock, and Heap Size Settings 

If the name of the board which is to be used for creating a project is not among those available for selection, 
download the board description file (BDF) by using the Smart Configurator and set the board. 

1. Select the “Board” tab of the Smart Configurator and click on “Download more boards…”. 
 

 

 

2. Select the board description file for the board to be used and click on “Download”. 
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3. Read the description in the “End User License Agreement (Sample Code)” dialog box. If you agree, click 

on “Agree”. 
 

 

 

4. Select the board. Click on the “Browse” button for “Board:”. 
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5. Select the board to be used from “Target Board:” in the “Refactoring” dialog box and click on “Next”. 
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6. Confirm the statement in the dialog box and click on “Next”. 
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7. Similarly confirm the statement and click on “Finish”. 
 

 

 

8. The board has now been selected. 
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Make clock settings to suit the board to be used. 

1. Select the “Clock” tab of the Smart Configurator. 

2. Set the clock to be suitable for the board to be used. The signal at the PLL operating frequency is the 

clock source for the LCD panel. Here, suppose that the main clock is to be the clock source and set 

“Frequency Division” and “Frequency Multiplication” for the PLL circuit so that the PLL operating 

frequency will be 240 MHz. 
 
Table 4-2   Setting Clocks 

Evaluation Board Frequency of 

the Main Clock 

PLL Operating 

Frequency 

Division and Multiplication to Obtain the 

PLL Frequency from the Main Clock 

RSK RX72N 24 MHz 240 MHz 1/1 x 10 

Envision RX72N 16 MHz 240 MHz 1/1 x 15 

RSK RX65N 24 MHz 240 MHz 1/1 x 10 

Envision RX65N 12 MHz 240 MHz 1/1 x 20 
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Specify the size of the heap to be used by the emWin FIT module in creating the GUI. 

1. Select the “Components” tab and “r_bsp” as the component. 

2. Specify the required size for “Heap size”. The emWin FIT module usually requires from several tens to 

100 KB. Here, start by specifying “0x4000”. Increase the size as required. 
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4.4 Setting the LCD According to the Workflow of QE for Display [RX] 

Start QE for Display [RX] and set the LCD in the order of “1. Preparation”, “2. LCD Adjustment”, and “3. GUI 
Creation on LCD” in the workflow view. 

Start QE for Display [RX]. 

1. Select “Renesas Views” -> “Renesas QE” -> “LCD Main RX (QE)”. 
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4.4.1 Preparation 

Make the settings for “1. Preparation” in the workflow view of QE for Display [RX]. 

1. In “Selecting a project”, select the target project. Once the project is selected, the entries for “Evaluation 

board”, “LCD maker/Type”, and “Model name/Size” are automatically displayed. 

If you are using the board other than one of those listed in Table 4-3, select “Custom” in the “LCD 

maker/Type” combo box and add the information on the LCD to be used in the “Edit Custom Display 

Data” dialog box. 
 
Table 4-3   Correspondences between “Evaluation Board”, “LCD maker/Type”, and “Model name/Size” 

Evaluation Board LCD maker/Type Model name/Size 

RSKRX72N (V1.01) Newhaven Display International, Inc. NHD-4.3-480272EF-ATXL#-CTP 

EnvisionRX72N (V1.02) EastRising ER-TFT043-3 

RSKRX65N-2MB(1.03) Newhaven Display International, Inc. NHD-4.3-480272EF-ATXL#-CTP) 

EnvisionRX65N (V1.00) EastRising ER-TFT043-3 

 

2. Select “Use emWin” under “Selecting the GUI drawing tool”. 
 

 

 

  

Automatically displayed 

according to the selected project. 
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4.4.2 LCD Adjustment 

Install the LCD controller by using the Smart Configurator. 
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1. Select the “Components” tab of the Smart Configurator and click on the “Add component” icon. 

2. In the “New Component” dialog box, select “Graphics LCD Controller Module (r_glcdc_rx)” (version 1.40 

or a later version) and click on the “Finish” button. 
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3. If the LCD controller module is not displayed in the list of components in the “New Component” dialog 

box, click on “Download more software components”. 
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4. In the “FIT Module Download” dialog box, remove the check against “Show RX Driver Package only” and 

select “RX Family Graphic LCD Controller Module” (Rev. 1.40 or a later revision). 

5. Click on “Download”. 
 

 

 

6. Read the description in the “End User License Agreement (Sample Code)” dialog box. If you agree, click 

on “Agree”. 
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7. When “Graphics LCD Controller Module (r_glcdc_rx)” is displayed in the list of components, select it and 

click on the “Finish” button. 
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8. If you selected a board when creating the project, pins for use by the GLCDC are also set in response to 

adding the component for the GLCDC. You can confirm the settings of pins by selecting “Graphic - LCD 

controller” on the “Pins” tabbed page. If you are using a custom board, make the settings of pins on this 

tabbed page. 
 

 

 

9. Click on the “Generate Code” button     in the upper-right corner of the Smart Configurator window. The 

code is generated according to the settings. 

After code generation is finished, “Added” is displayed immediately below “Installing the LCD controller”. 
 

   

 

After that, adjust the LCD. 

Clicking on the “TCON/LCD setting”, “Timing adjustment”, “Graphic layer setting”, and “Image quality 
adjustment” buttons opens the “Display Tuning RX (QE)” views of QE for Display [RX] which correspond to 
each button and allows changing of the settings. In addition, clicking on the “Start Display Adjustment” button 
in each “Display Tuning RX (QE)” view allows adjustment of the display with real-time confirmation on the 
actual display. 

For details, refer to the help system entries for the “Display Tuning RX (QE)” views. 
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RX Family QE for Display [RX] Application Note 

R20AN0582EJ0110  Rev.1.10  Page 36 of 113 

Dec.25.20  

Modify any values that are in error. 

 

10. Click on “Timing adjustment”. 

11. The “Display Tuning RX (QE)” view of QE for Display [RX] opens. If a value has an error, an error mark   

is displayed. Modify the value so this error mark disappears. 
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12. Confirm that the value of “PLL Circuit Frequency [MHz]” matches the setting of the clock in the Smart 

Configurator. 

After you have confirmed that the value is correct, adjust the value of “Panel Clock Frequency [MHz]” 

displayed in red to indicate that it is in error. 

Here, select “10.000000”, which is the nearest available value to 9.0 MHz of the panel clock frequency for 

the LCD, from the combo box. 

Setting the panel clock frequency to 10.0 MHz creates an error in the value of “Horizontal Frequency 

[kHz]”, which is now displayed in red. 
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13. Hovering the mouse cursor over the erroneous value (the value of “Horizontal Frequency [kHz]”) 

displayed in red produces a display of the range of specifiable values. 

Hovering the mouse cursor over the label (“Horizontal Frequency [kHz]”) for the erroneous value 

produces a display of a description of how to eliminate the error. Modify the value in accord with this 

description. 
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14. Modify the setting so that the refresh rate and the horizontal frequency are within the range of specifiable 

values at the specified panel clock frequency. 

The following is a list of example settings when the panel clock frequency is 10 MHz. 
 
Table 4-4   Example of Timing Settings when the Panel Clock Frequency is 10 MHz (for RSK RX72N 

and RSK RX65N) 

Connected Device Item Value 

NHD-4.3-480272EF-ATXL#-CTP VPW 10 

VBP 2 

VDP 272 

VFP 2 

VTP 286 

HPW 41 

HBP 29 

HDP 480 

HFP 34 

HTP 584 

 

Table 4-5   Example of Timing Settings when the Panel Clock Frequency is 10 MHz (for Envision 

RX72N and Envision RX65N) 

Connected Device Item Value 

ER-TFT043-3 VPW 1 

VBP 7 

VDP 272 

VFP 8 

VTP 288 

HPW 14 

HBP 75 

HDP 480 

HFP 15 

HTP 584 
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The settings of the LCD can be adjusted by the GUIs for the display adjustment facilities while confirming the 
results on the actual display. The following shows an example of the adjustment of brightness from the 
“Image Quality Adjustment” tabbed page. 

 

15. Build a project with reference to section 4.5,Building the Project. 

16. Make the settings for the debugger and connect the board with reference to section 4.6, Connecting a 

Debugger and Executing the Program. 

17. Click on the “Start Display Adjustment” button. 
 

 

 

18. In the “Select a Program” dialog box, click on the “Start adjustment” button after selecting either of the 

following: 

• “Use the dedicated adjustment program.”: when setting up the state of the GLCDC for the LCD panel has 

not been completed 

• “Use user program.”: when setting up the state of the GLCDC for the LCD panel has been completed 

If the board has not been connected to the debugger, clicking on “Start adjustment” starts the connection. 
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19. When the following message is displayed, click on “Switch”. 

 

 

20. When the board is connected to the debugger and adjustment of the display is started, the “Start Display 

Adjustment” button is replaced by the “Finish Display Adjustment” button and the message “Display 

adjustment is ready.” appears in the console of QE for Display. When the console of QE for Display is 

not displayed, click on the “Display Selected Console” icon (     ) and select “QE for Display”.  
 

 
 

 

 

21. Select the “Image Quality Adjustment” tabbed page in the “Display Tuning RX (QE)” view, then select 

“Brightness” from the menu to the left. 
 

 

 



RX Family QE for Display [RX] Application Note 

R20AN0582EJ0110  Rev.1.10  Page 43 of 113 

Dec.25.20  

22. Modify the value for the gauge of “Quick Setting:” or the values of “Custom:” and click on the “Set the 

Register” icon (   ). 

The values are set in the registers and can be confirmed on the display of the connected board. 

Repeat modification of the values and settings of the registers until the display is as expected. 

The display can be confirmed by showing an image. For details on displaying an image, refer to section 

6.7, Image-Downloading Facility. 
 

 

 

23. After you have finished adjusting the values, click on the “Finish Display Adjustment” button. 
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24. The board is disconnected from the debugger and the “Start Display Adjustment” button is restored to 

replace the “Finish Display Adjustment”. 

The message “Tuning finished.” appears in the console of QE for Display. 
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25. Header files reflecting the results of adjusting the display are then output. 

Click on the “Generate file” button to output r_image_config.h and r_lcd_timing.h. They are output to src 

immediately under the project folder by default. The output destination folder can be changed by selecting 

the “Select folder” checkbox. 

The path for including the output header files is also automatically added. 
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4.4.3 GUI Creation on LCD 

Install the GUI drawing tool. 
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1. Select the “Components” tab of the Smart Configurator and click on the “Add component” icon. 

2. In the “New Component” dialog box, select “Graphic Library with Graphical User Interface (r_emwin_rx)” 

(version 6.14 or a later version) and click on the “Finish” button. 
 

    

 

  



RX Family QE for Display [RX] Application Note 

R20AN0582EJ0110  Rev.1.10  Page 48 of 113 

Dec.25.20  

3. If the graphic library is not displayed in the list of components in the “New Component” dialog box, click 

on “Download more software components”. 
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4. In the “FIT Module Download” dialog box, remove the check against “Show RX Driver Package only” and 

select “RX Family emWin v6.14 module”. 

5. Click on “Download”. 
 

 

 

6. Read the description in the “End User License Agreement (Sample Code)” dialog box. If you agree, click 

on “Agree”. 
 

 

 

  



RX Family QE for Display [RX] Application Note 

R20AN0582EJ0110  Rev.1.10  Page 50 of 113 

Dec.25.20  

7. When “Graphic Library with Graphical User Interface (r_emwin_rx)” is displayed in the list of components, 

select it and click on the “Finish” button. 
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8. Components the added component having dependencies with is automatically added. However, a 

component that has not been added or a component with a version that differs from the required one will 

lead to an error message or a warning. 

In such cases, add the required component or update the version. 

The following shows the error message for a component that has not been added (r_drw2d_rx) and 

warning messages regarding the version of a component (r_bsp). 
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Add the required component (r_drw2d_rx). 

9. Select the “Components” tab and click on the “Add component” icon. 

10. In the “New Component” dialog box, select “Drawing 2D engine driver for RX MCUs (r_drw2d_rx)” and 

click on the “Finish” button. 

If the component is not in the list of components in the “New Component” dialog box, click on “Download 

more software components”. 
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Update the component to the required version (r_bsp_rx). 

11. Right-click on the component for r_bsp and select “Change version”. 
 

 

 

12. Confirm “Available versions” in the “Change Version” dialog box and click on “Next”. 

13. Confirm “Setting Overview” and click on “Finish”. 
 

    

 

14. When the confirmation message is displayed in the “Change Version” dialog box, click on “Yes”. 
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15. When the confirmation message is displayed in the “Code Generation” dialog box, click on “Yes”. 
 

 

 

16. The error and warnings regarding the dependencies of components have now been resolved. 
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Set the IIC channel which is to be used with emWin. 

17. Select “r_sci_iic_rx” from the components. 

18. Change the setting for the IIC channel which is to be used with emWin. Specify the value of “MCU 

supported channels for CHn” of the channel to be used as “Supported”. 
 
Table 4-6   IIC Channel Numbers to be Used (Initial Values) 

Evaluation Board IIC Channel Number 

RSK RX72N 11 

Envision RX72N 6 

RSK RX65N 7 

Envision RX65N 6 
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19. When a board is selected in the creation of a project, setting the IIC channel to be used with emWin also 

sets the pins for use with the channel. Select “Serial communications interface” on the “Pins” tabbed 

page to confirm the settings of the pins. Set the pins here if you are using a custom board. 
 

 

 

20. When the pins have been set, click on the “Generate Code” button     in the upper-right corner of the 

window. The code is generated according to the settings. 

21. After code generation is finished, “Added” is displayed immediately below “Installing the GUI drawing tool 

driver”. 
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Make the initial settings for the GUI drawing tool. 

22. Clicking on the “Info setting” button displays the “emWin Setting” dialog box. 

23. Values are set according to the information on the board selected in the project. 

For “IIC channel number”, the channel number must match that specified as “Supported” by the 

“r_sci_iic_rx” component in the Smart Configurator. 

For details, refer to the explanation produced by clicking on the “Help” button. 

Confirm the settings and click on the “OK” button to close the dialog box. 
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24. A header file reflecting the initial settings for the GUI drawing tool is output. 

Click on the “Generate file” button to output r_emwin_rx_config.h. It is output to src immediately under the 

project folder by default. The output destination folder can be changed by selecting the “Select folder” 

checkbox. 

The path for including the output header files is also automatically added. 
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25. If the address of the frame buffer which has been set in the “emWin Setting” dialog box overlaps with 

section addresses, the section address must be changed. 

If the default value has been set, since the address of frame buffer 2 (0x00000100) means that the buffer 

overlaps with addresses of the SU and subsequent sections (from 0x00000004) in the RX65N RSK and 

RX65N Envision, the section address must be changed. However, it does not require changing in the 

RX72N RSK and RX72N Envision. 
 

    

 

Table 4-7   Addresses of Frame Buffers (Initial Values) 

Evaluation Board Address of Frame Buffer 1 Address of Frame Buffer 2 

RSK RX72N 

Envision RX72N 

0x00800000 0x00840000 

RSK RX65N 

Envision RX65N 

0x00800000 0x00000100 

 

Table 4-8   Example of changing addresses of the SU and subsequent sections 

Evaluation Board Address of section 

RSK RX72N 

Envision RX72N 

0x00000004 (default value) 

RSK RX65N 

Envision RX65N 

0x00840000 
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26. Select “Properties” under the “Project” menu to open the “Properties” window. 

Select “Settings” in the “Properties” window then “Section” in the “Tool Settings” tabbed page. Click on 

the “Browse” button for “Section (-start)”. 
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27. Change the section address so that the addresses do not overlap with those of the frame buffer. Here, it 

is changed from “0x00000004” to “0x00840000”. Click on the “OK” button. 
 

    

 

28. Change the compiler options to make the drawing engine work properly. 

Select “Settings” in the “Properties” window then “Object” in the “Tool Settings” tabbed page. Check the 

“Allocates const qualified variables to 4-byte boundary alignment sections (-nostuff=C)” checkbox. 

Click on the “Apply and Close” button on “Settings” in the “Properties” window. 
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Install AppWizard, which is to be used to create the GUI. 

29. Click on the “Setting” button under “Generate GUI” to open the “AppWizard settings” dialog box. 

30. Click on the “Installing AppWizard” button to install AppWizard by following the instructions of the 

AppWizard setup wizard that is displayed. 
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31. After having installed AppWizard, click on the “OK” button to close the “AppWizard settings” dialog box. 
 

 

 

32. The “Start GUI drawing tool” button is now active. 

Click on this button to start AppWizard. 
 

    

 

Note: The usage of AppWizard may differ from the way which is described in this application note due to 

changes to the specifications. For the usage of AppWizard, refer to its help system. 
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33. When AppWizard is started, the “aw” project folder of AppWizard is automatically created immediately 

under the project. This folder contains Resource, Simulation, and Source folders and the project file for 

AppWizard (aw.AppWizard). 
 

 

 

34. In the AppWizard project, the board to be used, display size, and color depth per pixel have automatically 

been specified. 

The setting values can be confirmed in the “Edit project properties” dialog box which is opened from the 

“Edit Options” item of the “Project” menu. 
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35. Create a GUI with AppWizard. 

Start by adding a screen. Clicking on the “Screen” button adds “Screen ID_SCREEN_00”. Multiple 

screens can be set and this allows switching between their displays. 
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36. After that, add an image. Clicking on the “Image” button adds “Image ID_IMAGE_00”. The position and 

size are adjusted in “Editor” or “Properties”. In this case, stretch the image to fill the LCD screen in 

“Editor”.  
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37. Set an image. Open “Set bitmap” in “Properties” and click on the rectangle below the label. Select a 

desired image from “Select image for mode <>” and click on “Select”. 
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38. Add a button. Clicking on the “Button” button adds “Button ID_BUTTON_00”. The position and size are 

adjusted in “Editor” or “Properties”. 
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39. Set images to indicate when the button is and is not being pressed. Expand “Set bitmaps” in “Properties” 

and click on the square under “Unpressed”. Select a desired image from “Select image for mode 

<Unpressed>“ and click on “Select”. 
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40. The selected image is set as “Unpressed”. Set the image for “Pressed” in the similar way. 
 

 

 

41. After having set images for both the “Unpressed” and “Pressed” states, set the bitmap format applied to 

the image. Click on “Images”. 

(41 to 43 are unnecessary steps if you are using AppWizard V1.08_6.14d or later. Go to step 44. 

For details, refer to 8.4.2 The setting of the bitmap format in the AppWizard.) 
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42. Click in the 'Format' column of an image entry and select the bitmap format. 

Select [True color with alpha, RB swap, alpha inverted] for the bitmap format of the button and [High 

color (565), RB swap] for the bitmap format of the image. 
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43. After setting the bitmap format for all the images, click on “Apply”. 
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44. Clicking on the “Start play mode” button located at the upper right confirms the operation of the created 

GUI in the preview. Clicking on the button in the preview, you can confirm difference between pressed 

and unpressed. Clicking on the “Esc” button closes the preview. 
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45. Output code from AppWizard. 

Select the “Export & Save” item from the “File” menu of AppWizard. 

Code is output in the “Source” and “Resource” folders under the “aw” project folder of AppWizard. The 

“Source” and “Resource” folders are automatically specified as the target folders for building. 
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46. Include code for displaying the created GUI in the main() function. 

Click on the “Show sample code” button in the lower part of “3. GUI Creation on LCD” of QE for Display 

[RX]. 

After clicking on the “Copy to the clipboard” button in the “Show sample code” dialog box, click on the 

“OK” button to close it. 
 

    

 

47. Paste the copied code under the user code within the main() function. 
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4.5 Building the Project 

 
Build the project and make the load module according to the following procedure. 

 

1. Click on the project you want to build (e.g. QE_for_Display_RX65N_Envision HardwareDebug).  

2. Click on “Build”. 
 

 

 

3. When the “Console” panel displays 'Build complete.', the build operation is complete. 
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4.6 Connecting a Debugger and Executing the Program 

1. Click on the project you want to debug (e.g. QE_for_Display_RX65N_Envision HardwareDebug).  

2. Click on “Debug Configurations” from the “Run” menu item. 
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3. Select the “Connection Settings” tab on the “Debugger” tabbed page of the “Debug Configurations” dialog 

box. 

4. Change the value for “Main Clock Source” to “EXTAL”. 

5. Change the values for “Extal Frequency [MHz]” and “Connection Type” according to the board. Refer to 

section 2, Operating Environment for the values. 

6. Change the value for “Power Target From The Emulator (MAX 200mA)” according to the board and click 

on the “Apply” button. Clicking on the “Debug” button starts the connection to the target. 
 
Table 4-8   Power Supplied from the Emulator 

Evaluation Board Power Supplied from the Emulator 

RSK RX72N 

RSK RX65N 

No 

Envision RX72N 

Envision RX65N 

No 

 

Note: To supply power to the RSK RX72N and RSK RX65N, use an external power source having a stable 

DC output (min. 10 W) and center-positive connector. 

 

 

 

  



RX Family QE for Display [RX] Application Note 

R20AN0582EJ0110  Rev.1.10  Page 79 of 113 

Dec.25.20  

7. When the following message is displayed, click on “Switch”. 

 

 

8. When downloading of the load module is completed, the “Debug” perspective opens. 
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9. Click on “Resume” on the tool bar. The program is executed and breaks at the beginning of the main 

function. 
 

 

 

10. After a break occurs at the beginning of the main function, click on “Resume” again on the toolbar. 
 

 

 

11. When the setting of the display device is done correctly, the following screen will be displayed on the LCD 

panel. Touch the button, the color changes as you create it. 
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5. Hardware 

5.1 Configuration of Hardware 

Table 5-1 shows the LCD panel used in this application note. 

 

Table 5-1   LCD Panel Used in the Sample 

Board Information on the LCD Panel Product 

RSK RX72N 

RSK RX65N 

Manufacturer: Newhaven Display Co. 

Part number: NHD-4.3-480272EF-ATXL#-CTP 

Display size:480 x 272 

Synchronization signal: VS, HS, DE (three signals)  

Built-in touch controller 

Envision RX72N 

Envision RX65N 

Manufacturer: EastRising Co. 

Part number: ER-TFT043-3 

Display size:480 x 272 

Synchronization signal: VS, HS, DE (three signals)  

Built-in touch controller 

 

5.2 Pin Functions 

The following shows pins used on each RSK and Envision and describes the pin functions used. Select the 
pins according to the product you are using. Pin functions are automatically set by using the Smart 
Configurator and QE for Display [RX]. 
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Table 5-2   Pins and Functions to be Used (RSK RX72N) 

Connected 

Device 

Pin Name Input/Output Description 

NHD-4.3-
480272EF-
ATXL#-CTP 

P14/LCD_CLK-B Output Outputs the panel clock. 

P13/LCD_TCON 0-B Output Outputs the synchronization signal (VSYNC). 

PJ2/LCD_TCON 2-B Output Outputs the synchronization signal 
(HSYNC). 

PB1/LCD_TCON 3-B Output Outputs the synchronization signal (DE). 

PC5/LCD_DATA 0-B Output Outputs the LCD signal R[3]. 

P82/LCD_DATA 1-B Output Outputs the LCD signal R[4]. 

P81/LCD_DATA 2-B Output Outputs the LCD signal R[5]. 

P80/LCD_DATA 3-B Output Outputs the LCD signal R[6]. 

PC4/LCD_DATA 4-B Output Outputs the LCD signal R[7]. 

P55/LCD_DATA 5-B Output Outputs the LCD signal G[2]. 

P54/LCD_DATA 6-B Output Outputs the LCD signal G[3]. 

P11/LCD_DATA 7-B Output Outputs the LCD signal G[4]. 

P83/LCD_DATA 8-B Output Outputs the LCD signal G[5]. 

PC7/LCD_DATA 9-B Output Outputs the LCD signal G[6]. 

PC6/LCD_DATA 10-B Output Outputs the LCD signal G[7]. 

PJ0/LCD_DATA 11-B Output Outputs the LCD signal B[3]. 

P85/LCD_DATA 12-B Output Outputs the LCD signal B[4]. 

P84/LCD_DATA 13-B Output Outputs the LCD signal B[5]. 

P57/LCD_DATA 14-B Output Outputs the LCD signal B[6]. 

P56/LCD_DATA 15-B Output Outputs the LCD signal B[7]. 

PQ1/SSCL11 Input/output Inputs or outputs for the clock of the I2C 
interface connected to the touch controller. 

PQ2/SSDA11 Input/output Inputs or outputs for the data of the I2C 
interface connected to the touch controller. 

P27/general-purpose 
input/output port 

Output Backlight 

PK4/general-purpose 
input/output port 

Output Panel reset 

PL3/general-purpose 
input/output port* 

Output Touch controller reset 

Note: When PL3 is to be used, a resistor must be changed. For details, refer to the user’s manual of the 

evaluation board. 
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Table 5-3   Pins and Functions to be Used (Envision RX72N) 

Connected 

Device 

Pin Name Input/Output Description 

ER-TFT043-3 PB5/LCD_CLK-B Output Outputs the panel clock. 

PB4/LCD_TCON 0-B Output Outputs the synchronization signal 
(VSYNC). 

PB2/LCD_TCON 2-B Output Outputs the synchronization signal 
(HSYNC). 

PB1/LCD_TCON 3-B Output Outputs the synchronization signal (DE). 

PB0/LCD_DATA 0-B Output Outputs the LCD signal B[3]. 

PA7/LCD_DATA 1-B Output Outputs the LCD signal B[4]. 

PA6/LCD_DATA 2-B Output Outputs the LCD signal B[5]. 

PA5/LCD_DATA 3-B Output Outputs the LCD signal B[6]. 

PA4/LCD_DATA 4-B Output Outputs the LCD signal B[7]. 

PA3/LCD_DATA 5-B Output Outputs the LCD signal G[2]. 

PA2/LCD_DATA 6-B Output Outputs the LCD signal G[3]. 

PA1/LCD_DATA 7-B Output Outputs the LCD signal G[4]. 

PA0/LCD_DATA 8-B Output Outputs the LCD signal G[5]. 

PE7/LCD_DATA 9-B Output Outputs the LCD signal G[6]. 

PE6/LCD_DATA 10-B Output Outputs the LCD signal G[7]. 

PE5/LCD_DATA 11-B Output Outputs the LCD signal R[3]. 

PE4/LCD_DATA 12-B Output Outputs the LCD signal R[4]. 

PE3/LCD_DATA 13-B Output Outputs the LCD signal R[5]. 

PE2/LCD_DATA 14-B Output Outputs the LCD signal R[6]. 

PE1/LCD_DATA 15-B Output Outputs the LCD signal R[7]. 

P33/SSCL6 Input/output Inputs or outputs for the clock of the I2C 
interface connected to the touch controller. 

P32/SSDA6 Input/output Inputs or outputs for the data of the I2C 
interface connected to the touch controller. 

P67/general-purpose 
input/output port 

Output Backlight 

PB3/general-purpose 
input/output port 

Output Panel reset 

P66/general-purpose 
input/output port 

Output Touch controller reset 
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Table 5-4   Pins and Functions to be Used (RSK RX65N) 

Connected 

Device 

Pin Name Input/Output Description 

NHD-4.3-
480272EF-
ATXL#-CTP 

PB5/LCD_CLK-B Output Outputs the panel clock. 

PB4/LCD_TCON 0-B Output Outputs the synchronization signal (VSYNC). 

PB2/LCD_TCON 2-B Output Outputs the synchronization signal 
(HSYNC). 

PB1/LCD_TCON 3-B Output Outputs the synchronization signal (DE). 

PB0/LCD_DATA 0-B Output Outputs the LCD signal R[3]. 

PA7/LCD_DATA 1-B Output Outputs the LCD signal R[4]. 

PA6/LCD_DATA 2-B Output Outputs the LCD signal R[5]. 

PA5/LCD_DATA 3-B Output Outputs the LCD signal R[6]. 

PA4/LCD_DATA 4-B Output Outputs the LCD signal R[7]. 

PA3/LCD_DATA 5-B Output Outputs the LCD signal G[2]. 

PA2/LCD_DATA 6-B Output Outputs the LCD signal G[3]. 

PA1/LCD_DATA 7-B Output Outputs the LCD signal G[4]. 

PA0/LCD_DATA 8-B Output Outputs the LCD signal G[5]. 

PE7/LCD_DATA 9-B Output Outputs the LCD signal G[6]. 

PE6/LCD_DATA 10-B Output Outputs the LCD signal G[7]. 

PE5/LCD_DATA 11-B Output Outputs the LCD signal B[3]. 

PE4/LCD_DATA 12-B Output Outputs the LCD signal B[4]. 

PE3/LCD_DATA 13-B Output Outputs the LCD signal B[5]. 

PE2/LCD_DATA 14-B Output Outputs the LCD signal B[6]. 

PE1/LCD_DATA 15-B Output Outputs the LCD signal B[7]. 

P01/SSCL6 Input/output Inputs or outputs for the clock of the I2C 
interface connected to the touch controller. 

P00/SSDA6 Input/output Inputs or outputs for the data of the I2C 
interface connected to the touch controller. 

PB7/general-purpose 
input/output port 

Output Backlight 

P97/general-purpose 
input/output port 

Output Panel reset 
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Table 5-5   Pins and Functions to be Used (Envision RX65N) 

Connected 

Device 

Pin Name Input/Output Description 

ER-TFT043-3 PB5/LCD_CLK-B Output Outputs the panel clock. 

PB4/LCD_TCON 0-B Output Outputs the synchronization signal 
(VSYNC). 

PB2/LCD_TCON 2-B Output Outputs the synchronization signal 
(HSYNC). 

PB1/LCD_TCON 3-B Output Outputs the synchronization signal (DE). 

PB0/LCD_DATA 0-B Output Outputs the LCD signal B[3]. 

PA7/LCD_DATA 1-B Output Outputs the LCD signal B[4]. 

PA6/LCD_DATA 2-B Output Outputs the LCD signal B[5]. 

PA5/LCD_DATA 3-B Output Outputs the LCD signal B[6]. 

PA4/LCD_DATA 4-B Output Outputs the LCD signal B[7]. 

PA3/LCD_DATA 5-B Output Outputs the LCD signal G[2]. 

PA2/LCD_DATA 6-B Output Outputs the LCD signal G[3]. 

PA1/LCD_DATA 7-B Output Outputs the LCD signal G[4]. 

PA0/LCD_DATA 8-B Output Outputs the LCD signal G[5]. 

PE7/LCD_DATA 9-B Output Outputs the LCD signal G[6]. 

PE6/LCD_DATA 10-B Output Outputs the LCD signal G[7]. 

PE5/LCD_DATA 11-B Output Outputs the LCD signal R[3]. 

PE4/LCD_DATA 12-B Output Outputs the LCD signal R[4]. 

PE3/LCD_DATA 13-B Output Outputs the LCD signal R[5]. 

PE2/LCD_DATA 14-B Output Outputs the LCD signal R[6]. 

PE1/LCD_DATA 15-B Output Outputs the LCD signal R[7]. 

P01/SSCL6 Input/output Inputs or outputs for the clock of the I2C 
interface connected to the touch controller. 

P00/SSDA6 Input/output Inputs or outputs for the data of the I2C 
interface connected to the touch controller. 

P66/general-purpose 
input/output port 

Output Backlight 

P63/general-purpose 
input/output port 

Output Panel reset 

P07/general-purpose 
input/output port 

Output Touch controller reset 
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6. Using QE for Display [RX] 

This chapter describes the usage of QE for Display [RX] according to the actual flow of display adjustment. 
For details on the facilities of QE for Display [RX], refer to the help file which comes with QE for Display [RX]. 

6.1 Starting QE for Display [RX] 

Selecting “Renesas Views” -> “Renesas QE” -> “LCD Main RX (QE)” from the menu of the e2 studio starts 
QE for Display [RX] (Figure6-1). 

 

 

Figure6-1   Initial State of QE for Display [RX] 

After a project has been selected in “1. Selecting a project” in the workflow diagram of QE for Display [RX], 
selecting “Renesas Views” -> “Renesas QE” -> “Display Tuning RX (QE)” from the menu of the e2 studio 
opens the “Display Tuning RX (QE)” view of QE for Display [RX] (Figure6-2). 

Figure6-2 is the display of a block diagram of the hardware of the GLCDC, showing the path for the output of 
image data and the relationships between the positions where images are to be corrected. Clicking on 
“Brightness” or “Contrast” for the adjustment of image quality produces the “Image Quality Adjustment” 
tabbed page, which allows various adjustments. 
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Figure6-2   “Display Tuning RX (QE)” View 
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6.2 Setting Data on the LCD Panel 

Information on the LCD panel which is connected to the user system is specified. When the display is 
connected to a system under development, you need to compare and adjust the specifications of the LCD 
panel and the display controller and find specifiable and appropriate settings. Information that has been 
specified is used in comparison. 

The LCD mounted on the RSK is an NHD-4.3-480272EF-ATXL#-CTP manufactured by Newhaven Display 
International. The LCD mounted on the Envision is an ER-TFT043-3 manufactured by EastRising 
Technology Co., Ltd. 

For the package of QE for Display [RX] V2.0.0, selecting a project for which the board to be used has been 
specified in the “LCD Main RX (QE)” view displays information on the LCD panel. 

 

 

Figure6-3   Selecting the LCD Panel 

 

When information on the LCD panel is set, the display type can be specified by selecting from among three 
patterns. The display type adopted is 3 (the method of using Vsync, Hsync, and DE signals) for the LCD 
panel mounted on the RSK and Envision.  

For details on setting information on the LCD panel, refer to chapter 7, Setting Detailed Data on the LCD 
Panel. 

 

6.3 Setting the Output of Control Signals 

Select the “TCON/LCD Setting” tabbed page in the “Display Tuning RX (QE)” view and specify the settings 
for the output of control signals (Figure6-4). 

The following settings for the output of control signals are available on this page. 
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[Panel Driver Signal (TCON) Output Selection] 

Selection of output pins: 

Output to the LCD_TCON0 to LCD_TCON3 pins (TCON0 to TCON3) 

Active sense of control signals: 

Positive sense: [High Active] 

Negative sense: [Low Active] 

[LCD Setting] 

[LCD Output Format] 

24-bit RGB888 output: [24bit (GLCDC_OUT_FORMAT_24BITS_RGB888)] 

18-bit RGB666 output: [18bit (GLCDC_OUT_FORMAT_18BITS_RGB666)] 

16-bit RGB565 output: [16bit (GLCDC_OUT_FORMAT_16BITS_RGB565)] 

[Timing of Output Data] 

Output on rising edges of the panel clock: [Rising (GLCDC_SIGNAL_SYNC_EDGE_RISING)] 

Output on falling edge of the panel clock: [Falling (GLCDC_SIGNAL_SYNC_EDGE_FALLING)] 

[Background Color] 

0x00000000 to 0x00FFFFFF 

[Bit-endian of Output Data] 

Little Endian (GLCDC_ENDIAN_LITTLE) 

Big Endian (GLCDC_ENDIAN_BIG) 

[Pixel Order of Output Data] 

RGB (GLCDC_COLOR_ORDER_RGB) 

BGR (GLCDC_COLOR_ORDER_BGR) 

[LCD Backlight Control] 

Selection of control 

Selection of port number: 

PORT0 to PORTJ 

Selection of bit position: 

BIT0 to BIT7 

Active sense of control signals: 

Negative sense: [Low Active] 

Positive sense: [High Active] 

[LCD Reset Control] 

Selection of control 

Selection of port number: 

PORT0 to PORTJ 

Selection of bit position: 

BIT0 to BIT7 

Active sense of control signals: 

Negative sense: [Low Active] 

Positive sense: [High Active] 
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Figure6-4   “TCON/LCD Setting” Tabbed Page 
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The following lists the settings that match the specifications of the each RSK and Envision board. 

 

Table 6-1   Settings of TCON and the LCD Panel Used for the Application 

 RSK RX72N RSK RX65N Envision RX72N Envision RX65N 

Selection of output pins 

Vsync TCON0 TCON0 

Hsync TCON2 TCON2 

DE TCON3 TCON3 

Active sense of control signals 

Vsync Negative sense: [Low Active] Negative sense: [Low Active] 

Hsync Negative sense: [Low Active] Negative sense: [Low Active] 

DE Positive sense: [High Active] Positive sense: [High Active] 

[LCD Output 

Format] 

16-bit RGB565 output 

[16bit (GLCDC_OUT_FORMAT_16 

BITS_RGB565)] 

16-bit RGB565 output 

[16bit (GLCDC_OUT_FORMAT_16 

BITS_RGB565)] 

[Timing of Output 

Data] 

Output on rising edges of the panel clock 

[Rising (GLCDC_SIGNAL_SYNC_ 

EDGE_RISING)] 

Output on rising edges of the panel clock 

[Rising (GLCDC_SIGNAL_SYNC_ 

EDGE_RISING)] 

[Background 

Color] 

0x00000000 0x00000000 

[Bit-endian of 

Output Data] 

Little Endian (GLCDC_ENDIAN_LITTLE) Little Endian (GLCDC_ENDIAN_LITTLE) 

[Pixel Order of 

Output Data] 

BGR (GLCDC_COLOR_ORDER_BGR) RGB (GLCDC_COLOR_ORDER_RGB) 

[LCD Backlight Control] 

Selection of control Enabled Enabled 

[Port Number] PORT2 PORTB PORT6 PORT6 

[Bit Position] BIT7 BIT7 BIT7 BIT6 

Active sense of 

control signals 

Positive sense: [High Active] Positive sense: [High Active] 

[LCD Reset Control] 

Selection of control Enabled Enabled 

[Port Number] PORTK PORT9 PORTB PORT6 

[Bit Position] BIT4 BIT7 BIT3 BIT3 

Active sense of 

control signals 

Positive sense: [High Active] Positive sense: [High Active] 
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6.4 Setting the Graphics Layers 

Select the [Graphic Layer Setting] tabbed page in the [Display Tuning RX (QE)] view and specify the settings 
for the graphics. 

The following settings for graphics are available on this page. 

[Select Using Graphic Layer] 

Graphic layer 1 

Graphic layer 2 

Graphic layers 1 and 2 

[Graphic Layer 1 Setting] 

[Height of Image Data] 

16 to the value of VDP on the [Timing Adjustment] tabbed page 

[Width of Image Data] 

16 to the value of HDP on the [Timing Adjustment] tabbed page 

[Display Start Position (x-coordinate)] 

0 to the value of “VDP – 16” on the [Timing Adjustment] tabbed page 

[Display Start Position (y-coordinate)] 

0 to the value of “HDP – 16” on the [Timing Adjustment] tabbed page 

[Start Address of Frame Buffer] 

0x00000040 to 0xFFFFFFC0 

[Output Data Format] 

ARGB8888 (GLCDC_IN_FORMAT_32BITS_ARGB8888) 

RGB888 (GLCDC_IN_FORMAT_32BITS_RGB888) 

RGB565 (GLCDC_IN_FORMAT_16BITS_RGB565) 

ARGB1555 (GLCDC_IN_FORMAT_16BITS_ARGB1555) 

ARGB4444 (GLCDC_IN_FORMAT_16BITS_ARGB4444) 

CLUT8 (GLCDC_IN_FORMAT_CLUT8) 

CLUT4 (GLCDC_IN_FORMAT_CLUT4) 

CLUT1 (GLCDC_IN_FORMAT_CLUT1) 

[Graphic Layer 2 Setting] 

The same settings as those for [Graphic Layer 1 Setting] 

[Interrupts Setting] 

Selection of enabling VPOS detection 

Selection of enabling VPOS interrupts 

Selection of the use of a callback function 

[Callback Function Name] 

Desired character string 
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Figure6-5   “Graphic Layer Setting” Tabbed Page 
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The following lists the settings that match the specifications of the each RSK and Envision board. 

 

Table 6-2   Settings of Graphics Layers Used for the Application 

 RSK RX72N/RX65N Envision RX72N/RX65N 

[Select Using Graphic Layer] Graphic layer 2 Graphic layer 2 

[Graphic Layer 1 Setting] 

All items Disabled Disabled 

[Graphic Layer 2 Setting] 

[Height of Image Data] 272 272 

[Width of Image Data] 480 480 

[Display Start Position (x-

coordinate)] 

0 0 

[Display Start Position (y-

coordinate)] 

0 0 

[Start Address of Frame 

Buffer] 

0x00800000 0x00800000 

[Output Data Format] RGB565 

(GLCDC_IN_FORMAT_16BITS_ 

RGB565) 

RGB565 

(GLCDC_IN_FORMAT_16BITS_ 

RGB565) 

[Interrupts Setting] 

[Enable VPOS Detection] Enabled Enabled 

[Enable VPOS Interrupt] Enabled Enabled 

[Use Callback Function] Used Used 

[Callback Function Name] _VSYNC_ISR _VSYNC_ISR 
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6.5 Adjusting the Timing of Control Signals for the LCD Panel 

Clicking on the “Start Display Adjustment” button after the debugger is connected opens the “Select a 
program” dialog box. Selecting the program and clicking on the “Start adjustment” button starts adjustment of 
the display. 

 

 

Figure6-6   “Start Display Adjustment” Button 

 

 

Figure6-7   “Select a program” Dialog Box 
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During adjustment of the display, the message “Please tune the display. Do not restart or reset the program.” 
is displayed and the “Start Display Adjustment” button is replaced by the “Finish Display Adjustment” button. 
Changing the values shown in Figure6-8 changes the timing of the control signals. This tool directly writes 
the changed values to registers of the GLCDC so that they are reflected in the operation of the LCD panel on 
the board. 

 

 

 (Left button: Values on the display are set in the registers.  Right button: Changes to the register 

settings are made in real-time.) 

Figure6-8  Adjusting the Timing of Control Signals 

 

Enter the frequency of the PLL circuit in the box in the upper-left of the “Timing Adjustment” area and select 
the frequency of the panel clock from the combo box. The selected frequency is used to calculate the refresh 
rate, which is indicated at the bottom of the page, along with a value for any difference from the 
recommended value for the LCD panel. The value recommended for the LCD panel has been specified as 
the initial value. In this example, select 10 MHz. 
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After that, adjust the individual parameters. The result of adjustment being shown in red numerals means 
that the value is out of the range of specifications of the GLCDC and of the LCD panel. In such a case, 
adjust the value so that it is within the range of the specifications of the GLCDC and of the LCD panel. Check 
the range of values which are allowable in the specifications of the GLCDC and of the LCD panel by 
hovering the mouse over the adjusted value that is being shown in red. 

The recommended values for the LCD panel are also used for these initial values. The recommended value 
of the horizontal front porch (HFP) of the LCD panel is 2; however, this must be modified since it is out of the 
range of the specifications of the GLCDC. Modify the value to 3 or more to satisfy the specifications of both 
the LCD panel and GLCDC. After that, the display of the adjusted value is changed from red to black. 

When you determine the adjusted values, write the values from this tool to the registers of the GLCDC and 
check the results. 

 

 (Left button: Values on the display are set in the registers.  Right button: Changes to the register 

settings are made in real-time.) 

Figure6-9  Buttons for Setting Registers 

 

The following two methods are used to set or make changes to values in the registers. 

 

Table 6-3   Facilities for Setting or Making Changes to Values in Registers 

Button Name Description 

 Set the Register The settings are written to the registers. This button is only effective 
during adjustment of the display. 

 

 

Set the Registers 
in Real-time when 
the Parameters 
are Changed 

When this button is active, changes are automatically written to 
registers every time the setting is changed. This button is not active 
by default. 

Writing to the registers only proceeds when the display is being 
adjusted; no operation proceeds if the display is not being adjusted. 

 
If “Use the dedicated adjustment program.” is selected in the “Select a program” dialog box for use in 
adjusting the display and the display is correctly set, a one-pixel-wide red line is drawn around the outer 
periphery of a blue-colored image as shown in Figure6-10. 

 

 

Figure6-10   Display on the LCD Panel 
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Note: 

For the facility to write the adjusted values to registers in QE for Display [RX], the graphics screen is adjusted 
to be aligned with the upper left of the background screen when the timing is adjusted. 

For definitions of the graphics and background screens, refer to the RX65N Group, RX651 Group User's 
Manual: Hardware (R01UH0590) or RX72N Group User’s Manual: Hardware (R01UH0824). 

 

Due to the display type and specifications of the LCD panel, fine changes to setting values (e.g. moving by 
several pixels) or changes to particular settings may not appear on the LCD panel. For example, the LCD 
panels mounted on the RSK and Envision are of display type 3, which does not allow the movement of 
positions in response to changes to the settings for the back porches and so on. 
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6.6 Output of Control Signals and Reflecting the Results of Timing Adjustment 

The results of timing adjustment can be reflected in a program through the output of a header file. Clicking on 
the “Generating Header File” button of QE for Display [RX] (Figure6-11) generates a header file that reflects 
the specified control timing. 

 

 

Figure6-11   “Generating Header File” Button 

 

When you select “For Timing and TCON Settings” only and click on “Generate”, a header file is generated at 
the specified destination for output. The name of the header file and the output destination can be specified 
as desired. 

 

 

Figure6-12   Selecting “For Timing and TCON Settings” 

 

To reflect the timing of the project, output the header file with the name 'r_lcd_timing.h' in the following 
directory, and clean and build the project. 

 

Directory: 

<workspace folder>¥<project folder>¥src 
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6.7 Image-Downloading Facility 

In QE for Display [RX], image quality is adjusted by checking the LCD according to the characteristics of the 
LCD. The image that is displayed on the LCD can be changed without changing the program. 

Using the image-downloading facility downloads image data (binary file) from the personal computer to be 
displayed on the LCD. 

 

 

Figure6-13   “Send the Image File” Button 

 

Click on the “Send the Image File” button on the toolbar. 

 

 

Figure6-14   “Send the Image” Dialog Box 

 

Specify the address of the destination and the file to be sent in the “Send the Image” dialog box. By default, 
the value that has been set in the graphics 2 frame buffer control register is specified as “Address”. When 
specification of “Size” is omitted, the entire file specified in the “Sending File” edit box is written to the range 
from the address specified in the “Address” edit box. 

This application note includes sample image data. Send the following. 

File: 

Load_Sample_480x272_lit.bin 

 

When sending is successfully completed, color bars are displayed as shown in Figure6-15. 
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Figure6-15   Image on Completion of Sending 

 

  



RX Family QE for Display [RX] Application Note 

R20AN0582EJ0110  Rev.1.10  Page 102 of 113 

Dec.25.20  

6.8 Adjusting Image Quality 

Clicking on the items for image quality adjustment enclosed by red frames in Figure6-16 on the “Block 
Image” tabbed page makes the “Image Quality Adjustment” tabbed page appear, enabling the adjustment of 
image quality. 

 

 

Figure6-16   Buttons for Selecting the Adjustment of Image Quality 
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The “Image Quality Adjustment” tabbed page enables the adjustment of image quality. QE for Display [RX] 
supports “Calibration Route Setting” and four facilities for adjusting image quality: “Brightness”, “Contrast”, 
“Gamma correction”, and “Dither process”. 

Changes to these settings are reflected in real-time, allowing the adjustment of image quality with reference 
to the display on the LCD panel. 

Image quality is adjusted by using “Quick Setting” or “Custom”. If you select “Custom”, refer to the RX65N 
Group, RX651 Group User's Manual: Hardware (R01UH0590), RX72N Group User’s Manual: Hardware 
(R01UH0824) and the RX Family Graphic LCD Controller Module Using Firmware Integration Technology 
(R01AN3609), check the meanings of the settings made in each of the registers and the specifiable values, 
and adjust the image quality accordingly. 

 

 

Figure6-17   “Image Quality Adjustment” Tabbed Page 
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6.9 Generating a Header File with the Results of Adjusting Image Quality 

Click on the [Generating Header File” icon of QE for Display [RX] to generate a header file that reflects the 
results of image quality adjustment which have been specified (see Figure6-18). 

When you select “For Image Adjustment” only and click on “Generate”, a header file is generated at the 
specified destination for output. The name of the header file and the output destination can be specified as 
desired. 

 

 

Figure6-18   Generating “For Image Adjustment” 

 

To reflect the settings of image quality adjustment in the project, output the header file with the name 
'r_image_config_.h' in the following directory, and clean and build the project. 

Directory: 

<workspace folder>¥<project folder>¥src 

 

  



RX Family QE for Display [RX] Application Note 

R20AN0582EJ0110  Rev.1.10  Page 105 of 113 

Dec.25.20  

7. Setting Detailed Data on the LCD Panel 

If you select “Custom” from the “Maker/Type” pull-down list in the upper section of the dialog box shown in 
Figure6-2, the “Edit Custom Display Data” dialog box (Figure7-1) appears. Enter information on the LCD 
panel in this dialog box. 

 

 

Figure7-1   “Edit Custom Display Data” Dialog Box 

 

7.1 Entering Names for Registration 

Enter the desired names in “Maker/Type” and “Model Name/Size” in the “Edit Custom Display Data” dialog 
box (Figure7-2). These names will be registered in the drop-down list for selection. 

 

 

Figure7-2   Registering a Name 
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7.2 Selecting the Display Type 

Table 7-1, Main Control Signals, lists the control signals required for connecting an LCD panel. QE for 
Display [RX] supports devices which have three display types with combination of those control signals. 

 

Table 7-1   Main Control Signals 

Name Outline of Facility 

Horizontal 

synchronization signal 

(Hsync) 

The signal that generates the timing for one line to be displayed 

Vertical synchronization 

signal (Vsync) 

The signal that generates the timing for one screen to be displayed 

Panel clock (CLK) The signal that drives the sampling of pixels to be displayed 

Display enable (DE) The signal indicating that valid data are being output 

Data (Data) Data to be displayed 

 
The user must check which control signals are required in the specifications of the LCD panel in use and 
select the appropriate one from among the three display types shown in Table 7-2, Display Types and 
Control Signals to be Used. 

 

Table 7-2   Display Types and Control Signals to be Used 

Name Display type 1 

 

Display type 2 

 

Display type 3 

 
Horizontal 

synchronization signal 

(Hsync) 

Used Unused Used 

Vertical synchronization 

signal (Vsync) 

Used Unused Used 

Panel clock (CLK) Used Used Used 

Display enable (DE) Unused Used Used 

Data (Data) Used Used Used 
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7.3 Entering Control Timing 

Enter the control timing with reference to the datasheet for the LCD panel. Values entered under Typ. are 
used as the initial values for timing control. Values entered under Min. and Max. are used to check whether 
or not the timing as adjusted by using the QE for Display [RX] GUI is within the range. 

Figure7-3 shows the result of data input for the LCD panel mounted on the RSK. Enter values with reference 
to Table 7-3, Excerpt from the Datasheet for the LCD Panel on the RSK. 

 

 

Figure7-3   Result of Control Timing Input 
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Table 7-3   Excerpt from the Datasheet for the LCD Panel on the RSK 

Parameter Symbol 
Spec. 

Unit 
Min. Typ. Max. 

Clock cycle fclk - 9 15 MHz 

Hsync cycle 1/th - 17.14 - KHz 

Vsync cycle 1/th - 59.94 - Hz 

Horizontal Signal 

Horizontal cycle th 525 525 605 CLK 

Horizontal display period thd 480 480 480 CLK 

Horizontal front porch Thf 2 2 82 CLK 

Horizontal pulse width thp 2 41 41 CLK 

Horizontal back porch thb 2 2 41 CLK 

Vertical Signal 

Vertical cycle tv 285 286 399 H 

Vertical display period tvd 272 272 272 H 

Vertical front porch tvf 1 2 227 H 

Vertical pulse width tvp 1 10 11 H 

Vertical back porch rvb 1 2 11 H 

 

7.4 Editing Created Display Data 

When the “Edit and Delete the Custom Display...” menu item is executed after clicking on the menu button 
on the toolbar, the created display data can be re-edited. 

 

 

Figure7-4   “Edit and Delete the Custom Display...” Menu Item 
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8. Details of Settings 

This chapter gives supplementary explanations and notes for each of the procedures described in section 
1.1, Flow of System Development with QE for Display [RX]. 

 

8.1 Setting the GLCDC FIT Module in Ways not Supported for QE for Display [RX] 

The Smart Configurator can be used to change the settings of the GLCDC FIT module in ways that are not 
supported by QE for Display [RX]. However, changing the settings from the default values may lead to an 
error. Confirm the specifications of the GLCDC FIT module. 

For the specifications of the GLCDC FIT module, refer to the RX Family Graphic LCD Controller Module 
Using Firmware Integration Technology Application Note. 

 

8.2 From Execution to the End of Adjustment 

After the program has been created, start the debugger and execute the program. If the initial screen is not 
correctly displayed, the settings are not correct. Check the values adjusted by QE for Display [RX] and the 
settings of parameters of the GLCDC FIT module. 

Figure8-1 shows the flow of troubleshooting. 

 

 

Figure8-1   Troubleshooting 
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8.3 Setting the maximum memory size used in the GUI 

If your GUI contains many widgets, the GUI may not work properly when displayed on the screen. In this 
case, increase the value of “Maximum memory size used in GUI” in the “emWin Setting” dialog.  
The default setting is 80kB (1024 * 80 = 81920), so please set the value to match the GUI you have created, 
such as 100kB. 

 

Figure 8-2  [emWin setting] dialog 
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8.4 Notes on image drawing speed 

Here are some notes on image drawing speed. In addition, emWin FIT V6.14.g.1.20 has improved the GUI 
drawing process, so please download and use emWin FIT V6.14.g.1.20 or later. 

 

8.4.1 Note on using JPEG format images in AppWizard 

Since there is no JPEG decoder, drawing speed will be slow when using JPEG format images. Therefore, 
the use of JPEG format images is not recommended, however, by converting to bitmap format, the images 
can be used without slowing down the drawing speed. By converting to bitmap format, you can also save 
memory. 

To convert JPEG format to bitmap format, open “Set bitmap” in “Properties” and select an image in any 

JPEG format. AppWizard will automatically convert JPEG format to bitmap format. 

 

 

 

 

Figure 8-3 Open “Set bitmap” and select an JPEG format image 
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8.4.2 The setting of the bitmap format in the AppWizard 

This problem has been resolved in AppWizard V1.08_6.14d or later, so please download and use emWin FIT 
V6.14g.1.20 or later. 
 
In versions older than V1.08_6.14d, the AppWizard created an uncommon bitmap format when the color 
format was 16 bits. So, if the bitmap format applied to the image is [Auto], it will not be drawn well by the 
drawing engine. Follow the steps below to change the bitmap format. 
 
1. Click on the “Images” button in the lower left corner of the AppWizard. 

 

Figure 8-4 Click on the “Images” 

2. The “Images” dialog will open. In this dialog, you can select the format to use for the generated bitmap 
image. Click in the 'Format' column of an image entry and select the bitmap format. 
For images that need transparency, select “True color with alpha, RB swap, alpha inverted”. This is a 
32bpp format that can be drawn by the drawing engine. 
For images that do not have/need transparency, select “High color (565), RB swap”. This is a 16bpp 
format that can also be drawn in the drawing engine. 

 

 

 

 

 

 

 

 

 

Figure 8-5 Select the bitmap format 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
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10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
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